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Preface

You’ve heard of word processing? Welcome to Wave Processing. Sample Wrench XE has been designed to be a powerful and easy to use audio sample editor from the outset. It is based on its big brothers Sample Wrench Classic and Sample Wrench 24/96. Audio waves are stored and manipulated in 16 bit format, yielding CD quality. Wrench, like all dissidents products, is the direct result of our own need and desire for such a system. The people who created Sample Wrench are trained musicians, as well as being professional programmers and engineers. Whatever your background, we hope that Sample Wrench XE fills your needs and exceeds your expectations. 

We would like to thank the technical staffs of the various sampler manufacturers for their most important input. We would also like to thank nature for providing the bananas, strawberries, and kiwi fruit, and George Washington Carver for all the neat things he did with peanuts.

This manual is dedicated to DIYers everywhere.

Serial Numbers, Updates and Upgrades

A serial number is required to activate this program. Without it, the program will only run in demo mode. This prevents saving, MIDI transfers, and the like. Updates are released periodically, with new features added in accordance to demand, so if there’s something you want, let us know! Info on new products, promos, freebies, and technical support are available on our web site: http://www.dissidents.com. 

Purchasers of Sample Wrench XE are entitled to generous upgrade offers to its big brothers Sample Wrench Classic and Sample Wrench 24/96. These programs offer extensive signal processing capabilities, multiple editors, an advanced macro language, and numerous other features. Contact us or see our web site for details.

System Requirements

Computer:

Sample Wrench XE generally places very modest demands on your computer. Almost any Windows PC produced since the late 1990s will run Sample Wrench XE. It is designed to work with PC compatibles having at least a 66 MHz 486 CPU although slower systems may be used with some reduction in capability or convenience. A Pentium class or higher CPU is recommended for fastest use, but is not required.

Operating System:

Windows 95, 98, etc. is required. Wrench will not run under Windows 3.1.

Memory and Drives:

A minimum of 8 Meg RAM is required, although 32 Meg or more will speed processing. The larger the files you intend to edit, the more RAM your computer should have. The installation requires approximately 6 Meg of hard drive space.

Display Monitor:

Any compatible monitor will work fine. 800 X 600 resolution or greater is desired.

Audio Playback:

A Windows compatible sound card or internal audio is strongly recommended (with a MIDI interface for sampler transfer, if desired). Since Wrench allows you to preview sounds, some form of sound output is desired. This can range from the internal speakers found in some display monitors, to a direct connection to a Hi-Fi system. For final critical listening with MIDI based samplers, sounds should be downloaded to the sampler and then played back through an appropriate studio monitoring system.

A Note on Multi-tasking:

Wrench will happily multi-task with other programs. It is important to remember that Wrench will need to access system resources from time to time (such as MIDI ports or audio playback hardware). Where possible, Wrench tries to share system resources, but this is not always possible (or even desirable). If Wrench needs exclusive access to a resource it will only do so when necessary, freeing up the system for other applications when possible. One important consideration involves large sound sample transfers via MIDI system exclusive (SYS-EX) messages. You should not attempt to use other MIDI music programs while you are sending or receiving MIDI data as Wrench requires lone access to the MIDI port during this process. If this were not the case, a simple MIDI Note On message sent by another music program could abort the system exclusive message (as detailed in the MIDI Spec). The result would be chaotic, to say the least.

Installing Sample Wrench and Copy-Protection

To install Wrench onto your hard disk, simply run the program that you downloaded (it’s a self-installer). By default, it will create a directory on your hard disk called “dissidents” which contains the application directory “WrenchXE” and copy over all of the files required. Inside “WrenchXE” will be sub-directories called “Program” (where Wrench itself is), “Presets” (for example effects presets), “Scripts” (example macros) and “Sounds” (for example and tutorial sounds). Usage of the installer is quite straightforward. An Uninstaller is also provided.

The first time you run Sample Wrench XE it will ask for your serial number. Simply type it into the spaces provided and click “Register”. If you are just trying out the program, simply click on “Run as Demo”. This does everything the normal program does except it won’t record, save your edits, or transfer via MIDI/SMDI. 

Sample Wrench XE does not use any form of intrusive copy protection such as key disks or dongles. This means that we are trusting you not to copy this program and give it to your friends or co-workers. We do this because we do not wish to inconvenience legitimate users of this program. The end-user licensing of a single Sample Wrench is very straight forward: we don’t care if you install it on several different computers so long as only one copy is in use at any given moment. If you plan on running several simultaneous Sample Wrench’s, you must purchase one Sample Wrench per “seat” (contact us for multiple-seat licensing if you require it-it’s cheaper that way).

If you are the sort of person who feels no ethical or moral queasiness at the thought of giving away copyrighted software, be advised that we will prosecute to the fullest extent of the law. (Also, we’ll put you on a mailing list for the Psychotic Friends Network and introduce you to Larry, Master Phone Waxer of Las Vegas. If you’ve ever seen Larry, then you know exactly how much of a deterrent this is.)

Using the Manual

The entire manual is available on-line. It may be accessed via the Help menu, or through the context-sensitive Help buttons found in many dialog boxes. The tutorial section is reproduced in the following pages for your convenience. Here is a description of each section:

Tutorial

This is a practical, hands-on look at Sample Wrench XE and what it can do. It touches on many of the important features but is by no means an exhaustive workout. It should give you a good feel for the flow of the program. Even if you’re an old-timer with music and computers, we strongly suggest that you walk through this.

Fundamentals

This section details the modes of operation and general settings. It introduces the topics and gives how-to explanations. Details on recording, playback, file formats, markers and loops may be found here.

Functions

This gives details on the items found under the Functions menu, including EQ, level control, noise reduction, sample rate alterations, keymapping and looping aids.

Effects

This gives detail on the items found under the Effects menu, including AM, FM, reverb, chorus, impulse modeling, pitch shifting, time compression, and spectral warping.

General Reference

Specific information on Wrench’s startup characteristics, utilities, menu overview, and shortcut keys may be found here.

Samplers

This section gives details on transferring sounds to or from a MIDI or SMDI based sampler.

Quick How-To’s

These are short instructions on how to just about any basic operation in Wrench.

Frequently Asked Questions

This is a listing of commonly asked questions and answers concerning Sample Wrench and digital audio.

Starting Sample Wrench XE

From the Start menu:

Select WrenchXE from the Start menu bar. Once Wrench has started, have fun.

From the Desktop:

If you have used the default install, there will be a “dissidents” directory inside of your “Program Files” directory. Inside “dissidents” will be a “WrenchXE” directory, and inside of that will be the “Program” directory where you will find Wrench itself. 

Double click on the WrenchXE program icon to start the program. Once Wrench has started, have fun.

Tutorial Overview

Sample Wrench XE is a special edition of dissidents’ flagship sample editor, Sample Wrench. Sample Wrench XE contains many of the features and capabilities of its big brother, making it an excellent choice for the cost-conscious consumer. It's a quick and nimble tool with just the right balance of power and convenience.

Simply put, Wrench is designed to let you manipulate and alter sounds to your desire. In short, Wrench lets you see what your ears hear. It is to the world of sound what a desktop publisher is to words and images. With the flexibility and power of its many functions, the resulting sound may be so altered that it becomes a new sound in its own right. Wrench can be used as a standard sound sample editor, and in conjunction with a sound card. Just as importantly, Wrench can be used with MIDI or SMDI sampling devices.

Presently, there are a number of MIDI samplers and sound cards available to the musician. Generally, they all do a good job of capturing sound in a digital form, and playing it back. Unfortunately, most of them lack either a simple and easy-to-use user interface or the capability of significantly altering waveform data. This is kind of like having a V-12 racing engine run on only 5 cylinders! When accessing an outboard sampler, the basic use of Wrench is in sending the wave data to the computer where it will be modified, and then sent back to the sampler. In this way, you get to do things to the sound that the sampler can't do, and, you get to do it in a very friendly environment. Even if your sampler does sport some of Wrench's features, you will probably find Wrench to be more informative, and thus, more efficient. Perhaps just as important is the ability to crossload sounds. Since Wrench talks to many different samplers and stores waves in a common form, it is very easy to send sounds from one sampler to another. Besides MIDI samplers, Wrench can also be used with sound cards, many of which contain very simple editors without a decent number of effects or features. Also, sounds may be transferred to/from sound cards and MIDI samplers via Wrench. Finally, sounds may be transferred to/from other platforms since Wrench supports a variety of file formats. 

Wrench is a RAM-based sample editor. This means that it loads sound files into the computer's main memory (RAM) from disk rather than operating directly on the disk files. This approach has certain advantages. RAM is much faster than disk drives are, and thus, you get the fastest possible performance. Also, you are never working directly on original source material, so if you foul up an edit, you haven't lost the source. Interestingly, sample size is not limited by available RAM. Thanks to virtual memory, portions of your hard drive can be used for larger-than-RAM sound samples. In this way, you get the best of both worlds. The only cost to you is that once an edit session is finished, the sound sample must be saved back to disk. (If you forget, Wrench will warn you about closing a wave with unsaved edits). 

Let's take a closer look at how some of this is accomplished with an example. First, start up Wrench. Once Wrench is up and running, you should see a window with a title bar at the top. This is your editor. You will note that the borders contain small push-buttons and sliders. These allow you to zoom in/out and pan left/right/up/down. The size of the window may be adjusted by grabbing and moving any of the edges. Note that the sliders are scaled along with the window. In the upper right corner you will find the standard window close, maximize and minimize buttons.
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If you press the right mouse button (menu button), you will see a list of menus. They are File, Edit, View, Format, Sampler, Functions, Effects, Markers+Loops, and Help. The File menu allows you to open and save sounds, control playback and recording, initiate sample transfers, and quit Wrench. Edit contains items for common operations such as Undo and Delete, along with Cut, Copy, and Paste. View allows you to set the appearance of the editor, including axis units, colors, fonts, and a variety of graph variations.

The Format menu determines how newly saved waves will be written. Wrench can load and save waveforms in a variety of formats. Note that Wrench is smart enough to figure out the type of file it is reading in, so the desired type need only be checked for file save. Also, note that it is possible to override the default format choice when using the Save As dialog.

Moving on, the Sampler menu allows you to set a specific sampler. Functions and Effects contain all of the interesting DSP processes which you'll use to shape audio, including EQ, Reverb, and so forth. The Markers+Loops menu allows you to create and manipulate Markers (like bookmarks) and Loops (repeating sections).

The final menu is Help, which leads to on-line assistance. Help/About... shows the program version number and date, as well as our address. In order to keep things consistent for all users, the example will bypass the use a sampler and use an existing disk-based sound. 

You would like to load a wave from disk. Select File/Open. The file dialog appears. Using the Drives button, set the disk name to the WrenchXE disk or directory. The center area lists many of the available files. You may move through this list with the up/down arrows and scroll bar off to the right. Look for a file called Flute.demo and double click on it. The disk drive light should come on and a moment later, the edit window will contain a picture of the wave. The horizontal axis represents time, with the start of the wave at the extreme left. The vertical axis represents signal strength. This representation is called a time domain view, and is similar to what you would see on an oscilloscope.  If you're using Overviews (the default), the editor will be split into two sections: an upper overview of the entire wave, and a lower view you can use for closer inspection by zooming and panning in and around it. 

The Ever-Changing Flute
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Now that you have the flute loaded, you can start having some fun. First off, notice what happens when the window is resized; the wave is scaled to fit the new window. You can zoom in and out in both the horizontal and vertical directions by using the four double-arrow buttons. These change magnification by factors of two. Notice that as you zoom in, the slider knobs get progressively smaller. The knobs indicate how much of the wave you are presently looking at. You may also pan left, right, up, or down by using the single arrow buttons (panning is often referred to as scrolling). These will move your viewing position about 10% of the present view size. Note that when you pan, the position of the slider knob will change, indicating which part of the wave is presently in view. You may also pan by dragging the slider's knob to a desired view location. By clicking in the slider area next to the knob, you can page through a wave. You will be looking at the next page or data frame of the wave. In other words, the right-most edge will now be on the left, or vice versa (likewise for top to bottom). Note that once you zoom in far enough, the wave will not be drawn in a filled in manner, but rather, like a single pencil line. When the wave looks like this, you're ready for micro-surgery! A very quick way of zooming out completely is to select the Show Full button (four diagonal outward arrows).

All audio processes need to know which part of the sound you'd like to affect. Sample Wrench XE uses the standard “select an area with the mouse” technique, just like you'll find in most word processors or painting programs. To use, simply depress the left mouse button over the start of the area you'd like to edit. Sweep the mouse of the remaining edit area and then release the button. The edit area will now be highlighted. Note that this is completely separate from your zoom level. If you're using Overviews (the default), a bar will show up in the overview that corresponds to the edit area. A quick way to select the entire wave for editing is to use Edit/Select All.

Previewing the Wave

Seeing may be believing, but the ears have final say in matters of sound. It is possible to use the computer's sound circuits to listen to the wave. Be aware that the quality of this sound may be greater or less than that of the associated samplers. To listen to the flute, first make sure that the audio outputs are connected and turned up to a moderate level. There are a few different ways of listening to sounds with Sample Wrench. The easiest way is to simply click on the loudspeaker button with the little P in it, in the toolbar of the editor window (P stands for Playback). This will play the sound with limited looping, assuming that a loop has been set. The playback can be aborted early bit clicking on the loudspeaker button with the K (Kill Playback) button. Feel free to play the flute!  A convenient shortcut for playing the presently highlighted area is to hit the spacebar. Now that you can preview sounds, you'll be able to hear the results of your edits immediately. Sound good so far? Things are only going to get better!

Maximize (Scale to Full) and Undo

Let's dive right into a few functions. One very useful function is called Maximize. This increases the wave to its maximum amplitude. Judicious use of this function can keep your noise floor at its minimum. First, highlight an edit area or (preferably) select Edit/Select All. Now select Functions/Maximize. Wrench will calculate just how much gain this wave needs for you, and then apply it. Since no further input is needed from you, no function dialog is displayed. While Wrench is figuring out the gain, the mouse pointer will turn into an hourglass symbol, indicating that the editor is busy. Wrench will also update a progress bar in the lower right corner of the main window. Once the calculations are completed, the new wave is drawn and the mouse pointer is reset. Also, the elapsed calculation time is given in the lower left corner of the main window. If you'd like, you may preview this sound by selecting the P button as before. Note that the flute sounds basically the same, it's simply louder. 

If for some reason, you decided that you didn't like the results of this function, you could get back the previous wave by by selecting Edit/Undo. Do this now. Note that the wave that existed right before the Maximize function was used has reappeared. It's as if the function was never used. This will return the fully scaled wave. Do this by selecting Undo again. Select this one more time to get back the original unscaled wave.

Digital Equalization
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One of the more common signal processing functions used in day to day work is equalization, or EQ, as it is often called. This ranges from the simple bass and treble controls found in home stereo gear, up through to sophisticated parametric equalizers in use by studios and sound reinforcement professionals. EQ allows you to change the spectral balance or timbre of a sound. Wrench has an extensive digital equalizer. First, highlight an area to edit (select Edit/Select All). To see the Bass and Treble EQ section, select Functions/EQ Bass+Treble. 

There are two basic equalizing functions that can be used in Wrench. These functions are high/low pass filter and bass/treble shelve  (the full version of Sample Wrench also contains parametric and graphic equalizers along with XE’s bass & treble and filters sections). As an example, you are going to add a moderate amount of high frequency boost to the flute wave. The simplest way to do this is via the bass/treble shelving control. This control is more flexible than the average bass or treble control because it allows you to specify the frequency at which EQing starts to take place. For this example, use 2 kHz. Simply type the numbers 

2000 

into the Frequency slot. (If the slot is not selected, just click on it first, then type in 2000). Now, in order to get just a treble control, make sure that Use Treble is checked and Use Bass is not checked. Once this is done, adjust the Treble Boost/Cut slider for a moderate amount of gain, say 3 or 4 dB. To produce the EQ, click on the OK pushbutton at the bottom of the dialog. The mouse pointer will show the hourglass and the progress bar will advance as Wrench calculates the new wave. After a moment, the new equalized wave is drawn. Select the Play button in order to hear the new flute wave. The equalized flute should sound a little brighter than the original wave, and perhaps a bit breathy as well. (Note that excessive boost might cause the wave to become clipped and distorted, just as it would with a normal equalizer). The EQ section is very powerful and can alter waves in many ways. The Treble control is just one function of many. Before you proceed, select Undo to get back the original wave. Note that excessive boosting, or EQ’ing of waves which are close to full amplitude can produce clipping distortion, just as in a hardware equalizer.

You will find many other processes besides gain, EQ and the like in the Functions and Effects (FX) menus. These include items such as arbitrary envelope generation, echo, reverb, amplitude modulation, chorusing, and a host of others. We suggest that you play with these after reading the Functions and Effects sections. For now, let's continue to another area of interest.

Markers and Looping

If you have worked with samplers for a while, you know the importance of making good seamless loops. You probably also know the frustration of trying to achieve those ideal loops! Loops are a necessary evil if you want a sound to sustain over long periods of time (several seconds). Without loops, sustaining sounds would require tremendous amounts of memory. A loop is defined by start and end points within the wave. The audio circuitry in the sampler (or computer) plays the wave until it reaches the loop end point. When it gets to this position, the circuit immediately jumps back to the loop start point and continues playback. Every time the loop end is reached, the circuit jumps back to the start point. This goes on for as long as a key remains depressed. Visual editing is an absolute boon to the hardcore looper. By seeing what you're trying to loop, the whole process becomes much easier. Generally, you'll arrive at satisfactory loops in considerably less time. The trick is to visually determine front and back parts of the wave which are similar. By doing this, discontinuities in the loop are minimized, and thus tell-tale clicks and thumps are reduced. Some waves are easier to loop than others. Very clangorous or harmonically complex waves can be virtually impossible to loop perfectly. The flute wave is not particularly difficult. 

In this section, you're going to create a new sustain loop for the flute wave since the default loop was not very good. At this point, you're interested in the Loops+Markers menu. First of all, loops are shown on the wave drawing as vertical lines connected by a horizontal bar. Loop ID numbers are drawn at the intersections of these lines. To see where your loops are, select Loops+Markers/Loop Show. You should see one line at the front of the wave and one at the rear. Only one loop is presently in use. It has been pre-defined to indicate the sustain loop. You can verify all of this by selecting File/Properties (Info). Info will tell you the exact position of the loops (in samples). Wrench can deal with three different kinds of loops, a Sustain loop, a Release loop, and trial loops (for now, you only care about the Sustain loop). As you can see, this dialog provides other items of interest including the sampling frequency, wave size, and Marker locations. Markers are like bookmarks, and we'll take a look at them a bit later. Exit the Info dialog by selecting the OK button. 

The reason why the default loop is so lousy is because the start and end points were poorly placed (on purpose). Zoom in on the start by using the Zoom Buttons. Magnify your view until only a few cycles (repetitions) of the wave can be seen. Try to memorize the shape of the wave and pay particular attention to where the loop line intersects (is it above, on, or below the center line?) Now, by using the horizontal scroll slider, move over to the loop end. (If you can't see the horizontal loop line on the display, you've gone too far, so backup). You will notice that the cycles in this section of the wave look a bit different than in the first part. Also, this loop point is intersecting in a different area. So, that's two good reasons why the loop sounds so bad! To fix this, you'll need to pick out similar areas. First, zoom out fully so that you can see the entire wave again. (Select View/Show Full). The loop start was placed on the attack portion of the wave. Usually, this is not a good place to start a loop because the sound has not yet reached full volume. Fortunately, the loop end is reasonably placed. 
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What you would like to do now is reposition the loop start. You can do this by selecting Loops+Markers/Loop Set and typing in a position from the keyboard. A more direct way is to use the mouse to grab the loop start line and move it to where you want it to be. Do this by positioning the mouse over the vertical loop start line, where it intersects with the horizontal loop line. Press the left mouse button. When you do this, the mouse pointer turns into an Insert pointer, and a highlight line is drawn. As you move the mouse, the highlight line moves with it. This line represents where you'd like the loop start to be moved to. We would like to skip over the initial attack portion, so move somewhat to the right of the original position and release the mouse button. The wave will be redrawn, showing your new loop start. 

This positioning was rather broad. Although you are in the right area, you don't know if the precise intersection is that good. Usually, loop points are set at zero-crossing points on the wave. You would like to do this. Zoom in on the loop start until only a few cycles are visible. Chances are, it will not be on a zero-crossing. You will have to fine-tune your position. For the sake of convenience, look for a positive going zero-crossing (i.e., a point where the wave intersects the centerline as it rises). Grab the start line with the mouse as outlined previously, and move it to the desired location. Before proceeding, note the general shape of the wave in the vicinity of the loop point. By using the horizontal scroll slider, move to the loop end. You will probably have to reposition this one a bit as well. Try to find a zero-crossing area that looks like the one you just did. Reposition this point as you did the previous one. Once this is accomplished, the loop is done. You may audition your work by selecting the P button as you did before. If you made reasonable choices, the loop should be much smoother than the original. 

Successful looping is half art and half science. Do not be dismayed if this first attempt was less than perfect. As time progresses and you become more comfortable with Wrench and waves, your looping skill will increase. To make your life easier, Wrench XE offers various forms of crossfade looping for those more difficult sounds. As a side note, even though you only fiddled with one loop, you may define up to 256 different loops using Loops+Markers/Loop Set.  

For details on creating, managing, editing and other advanced uses of markers and loops, refer to the Markers and Loops section later on in the manual.

Final Helpful Items

You may have noticed one menu area which has been largely ignored up to now, and that's the middle to lower portion of the View menu. These items do not alter the wave, they simply make it a bit easier for you to read and interpret them. You have probably noticed that the horizontal and vertical axes are calibrated. The defaults are seconds for the time axis and percentage of full scale for the amplitude axis. These can be altered via the Horizontal and Vertical items to display a variety of formats. Also useful is an XY Readout. By selecting this, the XY position of the mouse pointer will be reported in the upper left-hand corner of the window. Color Point is useful when you are working at extreme magnifications. When this is selected, each individual sample is highlighted. Box Outline draws a box around the working wave area. Its purpose is purely aesthetic. Use it if you like it, ignore it if you don't. Overviews allows you to see a second drawing of the entire wave at the top of your edit window. The area you have zoomed in on is shown on the overview in reverse highlight. Further, the area that has been defined for editing is shown as a thin, highlighted bar along the top of the Overview. With Set Colors, you can customize the colors used to draw the waveform and such. Set Font brings up a standard Font Dialog. The selected font will used for the waveform labels and axis values. It is suggested that you stick with simple mono-spaced fonts of modest size in order to maximize the waveform drawing area.
Closing Down the Tutorial

To close the edit window, click on the Close button in the upper right corner. Since this operation will forget the contents of the editor, you are asked for verification. You could also select File/Close to leave Wrench.

Well, that wraps up the tutorial. At this point, you've been introduced to Wrench and have touched on a few of its many functions. Most of the major concepts have been covered and you should be able to fill in many of the details on your own. Wrench is very consistent in how you work with it. Fear not though, the next section gives the nitty-gritty details on everything! You may wish to experiment further with some of the supplied waves before you continue with the next section. This will allow you to get a tad more comfortable with Wrench.

Product License Agreement

Carefully read all the terms and conditions of this agreement prior to using the program. Use of the program indicates your acceptance of the terms and conditions. If you do not agree to these terms and conditions you may obtain a full refund by returning the unopened diskette package to the place of purchase. “SOFTWARE” refers to the computer software, documentation, and associated media.

1. SOFTWARE is protected by copyright laws and international copyright treaties. You may not use, modify, copy, or transfer SOFTWARE or any copy except as provided in this agreement.

2. You have the non-exclusive right to use SOFTWARE on a single computer. You may physically transfer SOFTWARE from one computer to another provided that SOFTWARE is only used on one computer at a time. You may not distribute, sell, or sub-license copies of SOFTWARE to others. You may not disassemble, decompile, or reverse engineer SOFTWARE.  All other rights and uses not specifically granted in this license are reserved by dissidents.

3. You may make backup copies of SOFTWARE for archival purposes only.

4. This license is effective until terminated. You may terminate it by destroying SOFTWARE and all copies thereof. The license will also terminate if you fail to comply with any term or condition of this agreement. You agree upon termination to destroy SOFTWARE and all copies thereof.

5. SOFTWARE is provided “as is” without warranty (either expressed or implied) as to the performance, merchantability, or fitness for a particular purpose. The entire risk as to the quality, accuracy, currentness, and performance of SOFTWARE and its output is assumed by the used.

6. dissidents warrants to the original licensee that the diskettes on which SOFTWARE is provided (if applicable) shall be free of defects in materials for a period of 90 days from the date of purchase, under normal use and service. If a defect is found, the medium will be replaced by dissidents without charge.

The above warranty is exclusive and in lieu of all other warranties, expressed, implied, or statutory, including, but not limited to, any implied warranties of merchantability or fitness for a particular purpose. dissidents’ liability is limited solely to the replacement of the defective diskettes, in its sole discretion, and shall not in any event include damages for loss of use or loss of anticipated profits or benefits or incidental or consequential costs, expenses or damages, including without limitation any data or information which may be lost or rendered inaccurate, even if dissidents has been advised of the possibility of such damages.

Some states do not allow a limitation on how long an implied warranty lasts, or

Limitation of incidental or consequential damages, so the above limitations may not apply to you. This warranty gives you specific legal rights, and you may also have other rights that vary from state to state. 
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